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Abstract - Zusammenfassung 

Im Sachgebiet 854 (Geovisualisierung) am Landesamt für Digitalisierung, Breitband und 

Vermessung werden regelmäßig Auszubildende und Praktikanten betreut. Die zeitgleiche 

praktische Ausbildung an mehreren Arbeitsplätzen war bisher nicht möglich, da eine 

ausreichende Bestückung mit kommerzieller Software wirtschaftlich nicht tragbar ist. Aus 

diesem Umstand entstand die Idee den bisherigen Arbeitsablauf der Erstellung einer 3D-

Landschaftsvislualisierung in die Umgebung der Open Source Software Blender zu 

implementieren. Im weiteren Verlauf soll ein Workflow entwickelt werden, der es 

bezüglich Umfangs und Komplexität auch fachlichen Einsteigern ermöglicht, 

ansprechende, dreidimensionale Landschaftsvisualisierungen als vorgerenderte 

Animationsfilme zu erstellen. 

Verschiedene Lösungswege bezüglich der verfügbaren Erweiterungen zu Blender 

wurden, hinsichtlich ihrer Eignung den geodätischen Raumbezug der Ausgangsdaten 

zufriedenstellend umzusetzen, untersucht. Nachdem die Erweiterung BlenderGIS als 

probates Werkzeug identifiziert wurde konnte ein Tutorial erarbeitet werden.  

Verschiedene Arbeitsabläufe werden auf die Tauglichkeit untersucht und ein Tutorial für 

zukünftige Praktikanten des Landesamtes entwickelt. Auf dieser Basis lässt sich 

feststellen, dass diese Anwendung durchaus Potential hat, die gestellten Aufgaben zu 

erfüllen und auch als Schulungssoftware am Landesamt für Digitalisierung, Breitband und 

Vermessung verwendet zu werden.  

Die Qualität und Quantität von Landschafts-Visualisierungen werden sich in Zukunft noch 

steigern. Aus diesem Grund sollten Grundkenntnisse in der Erstellung Teil der Ausbildung 

des geodätischen und kartographischen Nachwuchses sein. Die vorgelegte Arbeit kann 

als möglicher Einstieg in die Materie gesehen werden. 
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1 Einführung in die Thematik 

1.1 Eigene Motivation 

In Gesprächen mit Familie, Freunden und Bekannten werden Studierende der 

Fachrichtung »Angewandte Geodäsie und Geoinformatik« des Öfteren mit fragenden 

Blicken konfrontiert. Beschreiben sie dann die Tätigkeitsfelder professioneller Geodäten, 

beginnen von Raumbezug und Koordinaten zu berichten, ist die allgemeine Verwirrung 

der Zuhörer meist vollkommen. Fachfremden Menschen ist ein positiver, leichter Einstieg 

in die Welt der raumbezogenen Daten oft schwer zu ermöglichen. Anders jedoch, wenn 

als Gesprächsgrundlage eine ansprechende Geovisualisierung vorliegt. Dies könnte 

beispielsweise ein animierter Rundflug über einen vertrauten Landkreis sein. Begriffe wie 

digitales Geländemodel oder Orthofoto können so, praktisch im Flug, Interessierten 

nähergebracht werden. Aufgrund dieser wichtigen, vermittelnden Eigenschaft von 

Geovisulisierungen, wurde die Fragestellung dieser Bachelorarbeit im Kontext dieses 

Themenbereichs formuliert.  

1.2 Thematische Einordnung 

Raumbezogene Daten haben in den letzten Jahren quantitativ und qualitativ stark an 

Relevanz zugenommen. Um auch für fachfremde Nutzer einen Zugang zu diesen oft 

komplexen Informationen zu schaffen, kann der Fachbereich Geovisualisierung ein 

probates Werkzeug darstellen. Verdeutlicht wird dies besonders bei Anwendungen wie 

Routenplanung und Navigation. Im Gegensatz zur rein technischen Angabe von 

Koordinaten und Richtungen fällt es einem Anwender erheblich leichter, sich mit Hilfe 

eines virtuellen Stadtplans zu verorten, orientieren und einer gewünschten Route zu 

folgen. Die Möglichkeit, Karten durch Videosequenzen anzureichern, gespeicherte 

Geodaten virtuell begehbar (Virtual Reality VR) oder als Kombination von virtueller und 

realer Welt (Augmented Reality AR) erlebbar zu machen, erleichtert eine Kommunikation 

zwischen Bürgern und Planern oft erheblich. Auch im touristischen Bereich sind vielfältige 

Anwendungen, wie virtuelle Stadtrundgänge oder Imagefilme bestimmter Attraktionen 

denkbar.   
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Um diesen Werkzeugkasten für eine möglichst breite Anwenderschicht zu öffnen, 

verfestigte sich der Wunsch in dieser Bachelorarbeit Geovisualisierung mit Open Source 

Software umzusetzen. Quelloffene Software wie QGIS und Anwendungen wie 

OpenStreetMap haben bereits einen festen Anteil in vielen geodätischen und 

kartographischen Bereichen. Interessierte können ohne finanzielle Hürden, 

Aufgabenstellungen lösen und hochwertige geodätische Produkte erzeugen. 

1.3 Zielsetzung der Arbeit und methodisches Vorgehen 

Anwender ohne tiefgreifende Vorkenntnisse sollen mit Hilfe des hier vorgestellten 

Workflows in die Lage versetzt werden, eine vorgerenderte 3D-Landschaftsvisualisierung, 

ohne interaktive Komponente, jedoch mit einer Überblendung verschiedener Texturen 

und aktiven Labels der Ortsnamen zu erstellen. Als Datengrundlage sollen hierfür 

Geodaten der Bayerischen Vermessungsverwaltung verwendet werden. 

Bisherige Praktikanten am Landesamt für Digitalisierung, Breitband und Vermessung 

Bayern (LDBV) wurden als Teil Ihrer Ausbildung manchmal mit der Aufgabe betraut, einen 

solchen kurzen Film, mit kommerziellen Softwareprodukten, zu erstellen. Inhalt war 

meist ein Rundflug über einen Landkreis in Bayern. Betreut werden die Auszubildenden 

und Studenten während dieser Zeit von Thomas Meier, Sachgebietsleiter 854 

Geovisualisierung am LDBV. In Gesprächen stellte sich heraus, dass aufgrund der sehr 

hohen Lizenzkosten für kommerzielle Softwareprodukte sich aktuell eine gleichzeitige 

praktische Übungsphase mehrerer Teilnehmer sehr schwierig gestaltet. Diese 

Programme sind am Landesamt nur auf einzelnen Rechnern installiert, Praktikanten 

hingegen sind meist in Kleingruppen zu Gast im Sachgebiet 854. Da durch eigenständige 

Arbeit sachliche Inhalte meist am besten vermittelt werden, wäre es sinnvoll mehrere 

Rechner mit der gleichen Ausstattung an Software für die Ausbildung zur Verfügung zu 

stellen. Aus diesem Umstand entstand die Idee, die Open Source Software Blender auf 

die Eignung als Schulungssoftware für das Sachgebiet 854 des LDBV, im Rahmen dieser 

Bachelorarbeit zu untersuchen. Anfragen für Visualisierungen von Geodaten am 

Landesamt und somit auch Schulungsinhalte sind meistens Rundflüge über Gebiete, in 

der Größenordnung eines Landkreises. Höheninformationen aus einem digitalen 

Geländemodell dienen zur Erzeugung eines Gitternetzes.   
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Auf dieses Netz werden verschiedene Oberflächen, meist ein digitales Orthofoto und 

topographische Karten projiziert. Um die Orientierung für den Betrachter während des 

Überflugs zu erleichtern, bekommen markante Orte eine Beschriftung. Diese 

Textbausteine drehen sich während der Kamerafahrt mit, um so eine gute Lesbarkeit 

während des gesamten Films zu gewährleisten. Während des Überflugs findet außerdem 

ein fließender Wechsel zwischen den verschiedenen Texturen des Geländemodells statt. 

Anleitungen zur Verwendung der Open Source Software Blender kann man zahlreich im 

Netz und auch in gedruckter Form finden. Hat ein Anwender jedoch eine spezielle 

Aufgabenstellung, wird die Suche nach einem geeigneten Tutorial oft sehr zeitaufwändig 

und stellenweise auch unmöglich. So soll mit dieser Arbeit, unter Berücksichtigung der 

gestellten Anforderungen des Landesamtes, das Feld der bereits verfügbaren Ressourcen 

an Informationen durchleuchtet werden. Mit dieser Grundlage wird dann ein eigenes 

Konzept entwickelt, um die gestellten Aufgaben möglichst anwenderfreundlich 

umzusetzen. Im folgenden Schritt soll dieses Konzept dann praktisch umgesetzt werden. 

Dieses Ergebnis wird abschließend in einem Tutorial zusammengefasst.  

1.4 Begrifflichkeiten verwendeter Fachausdrücke 

1.4.1 Digitales Geländemodell 

Um späteren Verwirrungen vorzubeugen, ist es sinnvoll sich vorab bezüglich der 

inhaltlichen Verwendung einiger Fachbegriffe zu einigen. Einer Geovisualisierung liegt 

stets das digitale Geländemodell (DGM) zu Grunde. Häufig tauchen auch ähnlich 

klingende Bezeichnungen, wie digitales Oberflächenmodell, digitales Höhenmodell, 

Terrainmodell sowie die englische Bezeichnung digital elevation model (DEM) in diesem 

Zusammenhang auf. Das digitale Geländemodell beinhaltet Geometriedaten zur 

Beschreibung der Erdoberfläche ohne Bebauung und Vegetation. Der Begriff kann mit 

den Bezeichnungen digitales Höhenmodell, Terrainmodell und digital elevation model 

synonym verwendet werden. Bei einem Oberflächenmodell hingegen wird die 

Erdoberfläche mit Bebauung und Vegetation abgebildet. Die hier beschriebene Auflistung 

der verwendeten Begriffe ist sicherlich nicht als vollständig zu betrachten.   
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Ist jedoch der grundsätzliche Unterschied zwischen Gelände und Landschaft geklärt 

können weitere auftretende Begriffe schnell richtig eingeordnet werden.  

Oft dienen die in Geländemodellen gespeicherten Höheninformationen dazu, eine durch 

Triangulierung erzeugte Vermaschung zu erstellen. Auf dieser aus vielen Dreiecken 

zusammengesetzten Fläche, können in einem weiteren Schritt verschiedene Rasterbilder 

als Texturen gelegt werden.  

1.4.2 Digitales Orthofoto 

Aus Luftbildern, die für größere Gebiete in sich überlappenden Flugstreifen 

aufgenommen werden, entstehen durch rechnerische Entzerrung digitale Orthofotos 

(DOP). So zeigen diese Aufnahmen die Erdoberfläche lotrecht von oben. Bei Gebäuden 

können so beispielsweise nur die Dächer aber keine Teile der Fassaden mehr erkannt 

werden. Die dargestellte Erdoberfläche wird somit maßstabsgerecht und lagerichtig 

abgebildet. Diese Eigenschaften ermöglichen es ein Orthofoto mit einer digitalen Karte 

zu überlagern.  

1.4.3 Digitale topographische Karte 

“Topographische Kartenwerke sind maßstäblich verkleinerte, vereinfachte 

(generalisierte), inhaltlich ergänzte, erläuterte Grundrissdarstellungen der Erde 

(bzw. von Teilen der Erde). Das Anliegen topographischer Karten ist die 

Inventarisierung der natürlichen (z.B. Gewässer und Relief) und gesellschaftlichen 

Situationen (z.B. Siedlungen, Grenzen) und die Orientierung im Gelände.“ 

(Bill, 2016)  

Amtliche topographische Karte werden in verschiedenen Maßstäben angeboten. So 

bezeichnet eine DTK25 die amtliche digitale topographische Karte im Maßstab 1:25000. 

Die digitale Ortskarte (DOK) ist im Maßstab 1:10000 dargestellt. Die Bearbeitung der 

Daten wird in dieser Bachelorarbeit größtenteils mit der Open Source Software Blender 

erstellt.  
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1.4.3 Open Source 

 

„Als Open Source bzw. quelloffen wird eine Software bezeichnet, deren Quelltext 

(also die Anweisungen, aus denen die Software besteht) frei zugänglich ist und 

deren Lizenzierung von der Open-Source-Initiative anerkannt wird. Vereinfacht 

gesagt, können Sie solche Software selbst verändern, kopieren, verbreiten und 

nutzen, ohne dass Lizenzgebühren fällig werden.“ (Beck, 2018) 

1.5 Geodaten der Bayerischen Vermessungsverwaltung 

Die verwendeten Geodaten sind hauseigene Produkte des LDBV. Sie werden in einer 

für alle Daten angepassten räumlichen Ausdehnung und Projektion zur Verfügung 

gestellt. Da größere Gebiete an verschiedenen Befliegungstagen aufgenommen 

werden, müssen in einem vorbereitenden Schritt die vorliegenden Orthofoto-Kacheln 

farblich zueinander angepasst werden. Dabei ist der optisch stimmige Eindruck 

vorranging zu betrachten. Der Anpassungsprozess erfordert eine gewisse 

Einarbeitung und würde den Rahmen dieser Arbeit übersteigen.  

 

Abb.1: Geodaten 

Das DGM wird am Landesamt als Produkt einer Airborne-Laserscanning Befliegung 

(flugzeuggestütztes Laserscanning) gewonnen. Hierbei werden nach Bedarf Gebiete 

abgeflogen, ausgewertet und können dann in unterschiedlichen Gitterweiten, zwischen 

1m und 200m, Auflösungen mit Höhengenauigkeiten zwischen ±0,2m und ±5m und 

Abgabeformaten, ASCII-txt, ASCII-Grid, Binär-Grid und 3D Shape, bezogen werden.   
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Es stehen außerdem verschiedene Koordinatensysteme zur Verfügung, die sich auf das 

geodätische Datum ETRS89 beziehen. Für diese Aufgabe wurden die Daten im ESRI-ASCII-

Grid-Format verwendet. Dies ist eine Textdatei mit Höheninformationen und einer 

Georeferenzierung. Die amtlichen digitalen topographischen Karten werden 

vierteljährlich aktualisiert und stehen in 5 verschiedenen Maßstäben zur Verfügung. Alle 

Daten wurden im Koordinatensystem UTM Zone 32 bereitgestellt und georeferenziert 

mit TFW-Datei gespeichert. TFW ist eine Textdatei mit Informationen über den Ort, 

Maßstab und die Drehung eines im TIFF-Format gespeicherten Rasterbildes. Im Abschnitt 

4 werden diese Daten noch ausführlicher besprochen. 

 

2 Recherche und Entwicklung eines Konzepts  

2.1 Definition der angestrebten 3D-Landschaftsvisualisierung  

Beginnt man den Begriff 3D-Landschaftsvisualisierung thematisch einzuordnen, lohnt es 

sich zu Beginn allgemeine Definitionen auf ihren Inhalt zu überprüfen.  

“Geovisualisierung oder auch geographische Visualisierung (…) befasst sich mit 

der Entwicklung von Theorien, Methoden und Werkzeugen für die visuelle 

Exploration, Analyse, Synthese und Präsentation von räumlichen Daten für 

bestimmte Anwendungen und Nutzer. Sie stellt eine Spezialform der allgemeinen 

Visualisierung dar mit den spezifischen Merkmalen, Verwendung eines 3D-

Datenraums und georeferenzierte Objektdaten. Geovisualisierung integriert 

Ansätze aus der wissenschaftlichen Visualisierung, Kartographie, 

Bildverarbeitung, Informationsvisualisierung, explorativen Datenanalyse, GIS und 

Statistik. Es wird also ein integrativer bzw. interdisziplinärer Ansatz verfolgt, bei 

dem die Kartographie ein wichtiges Fundament bildet. Bezüglich der 

Gestaltungsmittel standen bei der Kartographie die statischen und 

interaktionsfreien Methoden (z.B. Papierkarten) im Mittelpunkt, bei der 

Geovisualisierung dagegen liegt der Fokus bei dynamischen bzw. interaktiven 

Verfahren.“(Bill, 2016)   
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Um den Begriff der Visualisierung von Geodaten abseits dieser sehr theoretischen und 

GIS-bezogenen Definition besser begreifbar zu machen, hilft es möglicherweise 

Berufsfelder von ausgebildeten Fachkräften zu betrachten: 

 

 Raum-, Stadt- und  

Landschaftsplanung 

 Architektur und  

Bauingenieurwesen 

 3D-Datenerfassung 

 Kommunen und  

Energieversorger 

 GIS-Industrie 

 Facility Management 

 (Geo-)Marketing 

 Umweltingenieurwesen 

 Transportlogistik 

 Print- und Internetmedien 

 Immobilienmanagement 

 

Durch diese Auflistung wird deutlich, wie weitreichend die interaktive Verwendung von 

Geodaten in viele Bereiche unseres täglichen Lebens Einzug gehalten hat. Die Navigation 

mit einem Automobil hat sich während der letzten 20 Jahre beispielsweise radikal 

verändert. Möchte man nun mehr über den Zweck von Geovisualisierung erfahren, ist 

der sogenannte map use cube nach MacEachren & Kraak ein anschauliches Mittel. Dabei 

werden vier Verwendungszwecke klassifiziert und in Relation zum Nutzer, dem 

Informationsgehalt und dem Grad der Interaktion, gestellt.   
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Abb.2: Map use cube (Darstellung von Thomas Meier) 

„Exploration: 

Erkundung (Erforschung) von Strukturen und Prozessen, eng verknüpft mit 

Kognition (Erkennen) und Explanation (Erklärung) 

Analyse: 

von Beziehungen in den Daten sowie Verifizierung bzw. Falsifizierung von 

Hypothesen 

Synthese: 

Präsentation bzw. Zusammenstellung eines oder mehrerer Datensäte in ganzem 

Umfang und Komplexität 

Präsentation: 

Kommunikation einer (generellen) Message in einer vorgefertigten Art und 

Weise“ (Bill, 2016)
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Die angestrebte Visualisierung eines Überflugs ist in diesem Modell in der Würfelecke der 

Präsentation einzuordnen. Es ist ein Produkt gerichtet an die breite Öffentlichkeit, mit 

der wenig grundlegend neue Informationen gezeigt werden soll und geringe Interaktion 

mit dem Nutzer angestrebt wird. Auch die Definition von Rüdiger Mach und Peter 

Petschek kreist die Thematik einer Landschaftsvisualisierung hinsichtlich Zielsetzung und 

Zielgruppe passend ein:  

„Gelände- und Landschaftsmodelle werden in unterschiedlichen Bereichen 

eingesetzt. Die Visualisierung dieser Daten hilft komplexe Informationen dem 

Auge in gewohnter Art und Weise zur Verfügung zu stellen. … 3D-Visualisierung 

macht Sinn und kann helfen, Fehler im Vorfeld von Planungen zu vermeiden, 

Informationen auch für Nichtfachleute verständlich zu machen und eine für viele 

Beteiligte nutzbare Kommunikationsplattform zu schaffen.“  

(Mach, Petschek, 2006) 

Nach der Analyse verschiedener thematischer Betrachtungen von 3D-

Landschaftsvisualisierung kommt man in einem weiteren Schritt dazu geeignete 

Werkzeuge für die Umsetzung zu identifizieren.  

„Auf Softwareebene gibt es eine überschaubare Palette an Produkten, die 3D-

Visualisierungen mit Geodaten unterstützen. Beispiele sind etwa Visual Nature 

Studio von 3DNature (http://3dnature.com/), das Open-Source-Projekt Virtual 

Terrain Project (http://vterrain.org/), die ESRI CityEngine 

(https://www.esri.com/en-us/arcgis/products/esri-cityengine/overview) oder 

Terragen (https://planetside.co.uk).” (Schauppenlehner, Lux, Graf, 2019)  

Eine Rahmenbedingung, die für diese Arbeit festgelegt wurde, war die Umsetzung der 

Visualisierung mit lizenzfreier Software. Blender als gut gepflegte Open Source 3D-

Animationssoftware erfüllt viele der geforderten Anforderungen. Es stehen unter 

anderen eine integrierte Echtzeit-Render Engine und ein kostenloses Werkzeug für den 

Videoschnitt zur Verfügung. Im weiteren Verlauf der Bachelor-Arbeit soll daher Blender 

tiefgreifend auf die potenzielle Eignung als Schulungssoftware untersucht werden.  

https://planetside.co.uk)/
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2.2 Verwendete Informationsquellen 

Bei der Erarbeitung einer neuen Software ist empfehlenswert als ersten Anlaufpunkt die 

offizielle Internetseite der Betreiber, im Falle von Blender die Organisation, aufzusuchen. 

Hier befinden sich neben einer Bedienungsanleitung auch erste Tutorials. Für den 

grundlegenden Einstieg ist dies sicherlich eine gute und richtige Wahl. 

 

 

Abb.3: Support auf www.blender.org 

Gedruckte Medien stehen reichlich im Handel und Bibliotheken zur Verfügung. 

Exemplarisch wird nachfolgend das sehr umfassende Werk Blender 2.7 von Thomas Beck 

etwas genauer betrachtet. Dieser Ratgeber gibt Einblick in sehr viele Bereiche der 

Software, erläutert die Entstehungsgeschichte und beschreibt viele Funktionen. Gegen 

Ende gibt der Autor sogar noch Hilfestellung zur Programmierung eigener Add-ons, also 

Erweiterungen der bestehenden Software. Bei der Lektüre wird dabei schnell klar, dass 

es sich bei Blender um eine mächtige Software mit enormen Möglichkeiten handelt. 
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Hauptsächlich werden jedoch in den praktischen Anwendungen Objekte modelliert und 

so freie, dreidimensionale Umgebungen erschaffen. Das ist auch nachvollziehbar, weil 

Blender genau zu für diesen Zweck in den 90er Jahren entstanden ist. Hat man jedoch 

eine spezielle Aufgabenstellung, wie es für diese Bachelorarbeit der Fall ist, kann ein so 

umfassendes Werk erschlagend wirken. Bei gedruckten Handbüchern kommt außerdem 

die rasante Entwicklung erschwerend hinzu. So gab es eine grundlegende Aktualisierung 

Ende Juli 2019 von Blender 2.79 auf Blender 2.8, welche meist etwas verzögert in 

gedruckten Büchern Einzug hält. Ein großer Vorteil einer gut gepflegten Open Source 

Software wie Blender ist die aktive Nutzergemeinschaft. So findet man sehr viele Videos 

mit Anleitungen auf Internetportalen wie YouTube. Hier sind ganze Kurse und viele 

Anleitungen zu finden. Etwaige Aktualisierungen der Software werden hier schnell 

aufgegriffen und neue Tutorials sind zeitnah verfügbar. Die große Problematik ist nur das 

Auffinden relevanter Informationen bei speziellen Problemstellungen. Eine Suchanfrage 

bei Google »Blender 2.8« bringt ein Ergebnis von 5,4 Millionen verfügbare Videos. So 

erfordert eine Suche nach brauchbarer Information sehr viel Zeit. Ist die Intension 

hingegen nur einen grundlegenden Einstieg in Verwendung von Blender zu erhalten, 

findet man im Netz mehr als genügend Informationen. Die Erzeugung einer 

Geovisualisierung, eines digitalen Geländemodells, mit aufgespanntem Orthofoto und 

digitaler Karte sind hingegen sehr spezielle Anforderungen und die Informationsvielfalt 

im Internet ist deutlich geringer. Es stehen verschiedene Anleitungen zur Verfügung, die 

eine Modellierung einer Phantasielandschaft beschreiben. Hierbei werden über 

Graustufenbilder ebene Gitternetze verformt, bis der gewünschte Eindruck einer 

Landschaft entsteht. Diese können dann in Animationsfilmen oder Computerspielen als 

Hintergrund eingesetzt werden. Diese Herangehensweise hat einen sehr freien und eher 

künstlerischen Ansatz und ist für Geodäten, mit Anspruch an einer realitätsnahen 

Abbildung der Erdoberfläche nicht brauchbar.  
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2.3 Entwicklung des eigenen Konzepts 

Wie in sehr vielen Bereichen gibt es auch in der Verwendung von Blender viele Wege die 

einen Nutzer an das gewünschte Ziel führen. Im nun folgenden Abschnitt wird die Wahl 

des hier verwendeten Konzepts besprochen und erläutert, aus welchem Grund dieses 

gewählt wurde. Für die ersten Versuche, eine virtuelle Landschaft mit Blender zu 

erschaffen, wurde die bereits unter »Vorhandene Informationsquellen« angesprochene 

Methode verwendet. Es wird hierbei ein ebenes Mesh, also Gitternetz, in das Blender - 

Projekt eingefügt. Das Gitternetz wird in einem nächsten Arbeitsschritt weiter unterteilt, 

das heißt die bestehende Fläche wird in weitere Unterflächen geteilt. Dies dient dazu 

mehr Detailschärfe in der Landschaft zu erzeugen. Über das Veränderungswerkzeug 

Displacement und ein Graustufenbild wird das Netz anschließend verformt. Alle 

Graustufenwerte der Pixel werden hierbei als Höhenwerte interpretiert. Über eine 

Skalierungsfunktion kann nun der gewünschte Grad der Verformung geregelt werden. 

Dieser Weg führt ohne Frage zu einem 3D-Geländemodell. Als Geodät vermisst man 

jedoch die Möglichkeit, die Geländefläche exakt nach den realen Höhenwerten zu 

verformen und auch geografische Projektionen werden vernachlässigt. 

Ein weiterer Workflow, der anschließend betrachtet wurde, basiert auf dem Add-on 

A.N.T. Landscape. A.N.T. steht in diesem Fall als Abkürzung für Another Noise Tool. 

 

Abb.4: A.N.T Landscape - Import 



2 Recherche und Entwicklung eines Konzepts 16 
 

 

Abb.5: A.N.T Landscape – Default Mesh 

Nach Aktivierung dieser Zusatzfunktion kann man ein bereits über die Displacement – 

Funktion verformtes Gitternetz einfügen. Es kann zwischen Landschafen mit 

unterschiedlichen Ausprägungen gewählt werden. Dies dient als Grundlage für weitere 

Bearbeitungsschritte und ist bei der Erstellung von nicht realen Landschaften sicherlich 

eine große Arbeitserleichterung. Für die Erstellung eines realen Landschaftsabbilds ist 

dieses Add-on hingegen nicht besonders geeignet.  

Bei der weiteren Recherche im Bereich Add-on zur Erstellung von Landschaftsmodellen 

wird man sicherlich auch auf das Add-on BlenderGIS aufmerksam. 

 

Abb.6: BlenderGIS 

Mit dieser Erweiterung hat das aktive Mitglied der Blender Nutzergemeinschaft domlysz 

einen Brückenschlag zwischen Blender und raumbezogenen Daten geschaffen. Dieses 

Add-on ist auf der Internetseite: https://github.com/domlysz/BlenderGIS frei verfügbar.   

https://github.com/domlysz/BlenderGIS
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Bei genauerer Betrachtung und Lektüre der Dokumentation überzeugte dieses Werkzeug 

hinsichtlich der vorliegenden Aufgabenstellung. Durch die Installation expandiert man 

Blender, um die Fähigkeit mit raumbezogenen Daten umzugehen. Jedoch weist der Autor 

domlysz zu Beginn der Anleitung bereits auf eine wichtige Tatsache hin:  

„Please don´t expect a success story if you don´t really know what you are trying 

to import in Blender…Use QGIS, to explore your data beforehand.” 

(domlysz, 2019)  

Blender ist ein Werkzeug, geschaffen für die dreidimensionale Modellierung von 

Objekten, das Rendern von Bildern und unzählige weiteren Anwendungen. Es ersetzt 

jedoch keine GIS Software und alle Daten, die in Blender mit Raumbezug importiert 

werden, sollten bereits vorab bezüglich der geographischen Projektion geprüft und 

eventuell in ein gemeinsames Koordinatensystem transformiert werden. Hat man diese 

Hürde jedoch überwunden stehen nach der Installation von BlenderGIS viele hilfreiche 

Funktion zur Verfügung. Es wird nun die Möglichkeit geboten einen Raumbezug für die 

Szene zu bestimmen. Ein wichtiger Unterpunkt ist das Spatial Reference System (SRS). 

Übersetzt bedeutet SRS das Koordinatensystem und damit die Projektion, mit der die 

Erdoberfläche in die planare Oberfläche einer Karte abgebildet wird. Da unterschiedliche 

Projektionen auch Auswirkung auf das dargestellte Größenverhältnis und die 

Winkelgenauigkeit einer Kartendarstellung hat, ist es wichtig diesem Aspekt 

Aufmerksamkeit zu schenken. Eine Vermischung von Daten der gleichen Region, 

projiziert in unterschiedlichen Koordinatensystemen, ist ohne vorangegangene 

Transformation in ein gemeinsames System, nicht ohne weiteres möglich. Daher sollten 

Daten, wie schon vorab von domlyz gefordert, mit einer geeigneten GIS - Software 

bezüglich des Raumbezugs untersucht und eventuell dort transformiert werden. Diese 

Vorarbeiten sollen jedoch nicht Bestandteil dieser Bachelorarbeit sein, da hier bereits 

einheitlich projizierten Daten des Landesamtes verarbeitet werden. Ein neues 

Bezugsystem kann über den sogenannten Spatial Reference Identifier (SRID) in der 

Suchmaske gefunden werden. Der SRID ist ein individueller Wert, der ein 

Koordinatensystem eindeutig identifiziert. Aufgebaut ist der Code mit Quelle: 

Schlüsselnummer. Wie in vielen geodätischen Bereichen verwendet man der Einfachheit 

halber den EPSG (European Petroleum Survey Group Geodesy) Code.   
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Diese Arbeitsgruppe hat die gängigsten Koordinatensysteme definiert und die 

Bezeichnungen werden weltweit von Fachleuten verwendet. Die in Deutschland noch 

immer häufig verwendeten Systeme Gauß-Krüger-Zonen 2 bis 5 des Deutschen 

Hauptdreiecknetzes haben beispielsweise die Bezeichnungen EPSG:31466 bis 

EPSG:31469. Den UTM-Zonen des europäischen terrestrischen Referenzsystems ETRS89 

32N und 33N wurden EPSG:25832 und EPSG:25833 zugewiesen. Die verschiedenen 

Nummern, oder auch die Gebrauchsnamen als Rückwärtssuche, können auf der 

Internetseite: http://www.epsg-registry.org/ ermittelt werden. 

 

 

 

Abb.7: EPSG Suchmaske 

„Blender (ebenso wie der Großteil alle 3D – Softwarepakete) ist nicht in der Lage 

mit Objekten umzugehen, die sich sehr weit entfernt vom Ursprung der Szene 

befinden. Darüber hinaus arbeitet Blender mit Koordinaten als single precision 

(float32), also einfacher Genauigkeit. Ein Wert mit einfacher Genauigkeit hat rund 

7 geltende Ziffern. Geographische Daten in einem projizierten System sind in der 

Regel in Metern gespeichert und generieren hohe Zahlenwerte. Projizierte 

Koordinaten müssen daher als double precision (float62), also doppelter 

Genauigkeit gespeichert werden. 

Darum ist es nötig ein Gitternetz nahe dem Ursprung der Szene zu setzen. Um 

einen Genauigkeitsverlust der Georeferenzierung zu vermeiden, ist es daher 

wichtig den Ursprung einer Szene in den Benutzereinstellungen im Auge zu 

behalten.“ (frei übersetzt aus dem Englischen, domlysz, 2019)  

http://www.epsg-registry.org/
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Diese Einstellungen werden in BlenderGIS über den Geoscene Manager gesteuert. 

Hierbei wird unter CRS das jeweilige Koordinatensystem der Szene eingestellt und unter 

Origin der Ursprung festgelegt. Die Koordinaten des Ursprungs werden am sinnvollsten 

als geographische Längen und Breitengrade eingegeben. Diese Werte können auf 

verschiedenen Portalen im Internet ermittelt werden.  

 

Abb.8: Geoscene Manager 

Die Transformation von Punkten zwischen verschiedenen Koordinatensystemen ist eine 

komplexe Aufgabenstellung. Daher ist es empfohlen, wie bereits beschrieben, alle Daten 

mit Hilfe einer GIS Software vorab zu transformieren, als georeferenzierten Datensatz 

abzuspeichern und erst dann in Blender zu importieren.  

 

Abb.9: ESRI Import ASCII Grid (.asc) - Einstellungen 

Das so vorab georeferenzierte und eventuell transformierte ASCII-Grid wird zur Szene 

hinzugefügt.  

Das Auswahlfeld des Imports bietet die Möglichkeit zwischen Mode Mesh und Point cloud 

auszuwählen. Mesh erzeugt gleich während des Importier-Vorgangs ein Gitternetz aus 

den Daten. Mit Point cloud werden die Daten als Punktwolke importiert und die 

Erzeugung eines Netzes muss in einem weiteren Schritt durchgeführt werden.  

Step bietet die Möglichkeit nur jeden n-ten Punkt zu verwenden. Die Erhöhung dieses 

Wertes kann, unter Detailverlust, den Importier-Vorgang stark beschleunigen. 
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Ebenso kann dieser Rechenschritt beschleunigt werden, wenn die ASCII – Datei mit einer 

newline-delimited rows – Formatierung erzeugt wurde. Hier wird jede Bildzeile der zu 

importierenden Datei in eine neue Code-Zeile geschrieben.  

 

Im nächsten Schritt wird das erzeugte Gitternetz über die Funktion Shade Smooth 

geglättet.  

"Das Shading entscheidet darüber, ob zwischen einzelnen Flächen interpoliert 

wird (Weichzeichnung) oder ob Sie die Grenzen der Faces erkennen können (…)" 

(Beck, 2018) 

 

Der Unterschied zwischen Shading-Optionen, Shade-Flat und Shade-Smooth wird in einer 

Detailansicht verdeutlicht. 

 

 

 

Abbildung 10: Shade Flat 

 

 

Abbildung 11: Shade Smooth  
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Die Texturen, mit denen das Gitternetz belegt wird, werden als Rasterbilder importiert. 

Georeferenced raster bezeichnen verschiedene Bildformate, denen jeweils ein 

sogenanntes World-file beiliegt.  

„Bilder werden als Raster-Daten gespeichert, in denen jede Zelle im Bild über eine 

Zeilen- und eine Spaltennummer verfügt. Zusätzlich zu diesen angeordneten 

Zeilen und Spalten von Pixeln werden auch reale Koordinaten benötigt. Um Bilder 

an der richtigen Position anzeigen zu können, müssen die Bildkoordinaten in reale 

Koordinaten konvertiert werden. Diese Konvertierungsdaten werden in der Regel 

mit dem Bild gespeichert. 

Im Allgemeinen werden bei einigen Bildformaten (z.B. Gitternetz, TIFF, BSQ, BIL 

oder BIP) die Informationen zur Georeferenzierung im Header der Bilddatei 

gespeichert. Bei anderen Bildformaten werden diese Informationen hingegen in 

einem separaten ASCII-World-File gespeichert.” (ESRI, 2019) 

 

  

Abb.12:Beispiel für World-File (LDBV, 2005) 

„Nach den Angaben der Fa. ESRI wird der Name des World File durch einfaches 

Anhängen eines „w“ an die Extension der Graphikdatei gebildet (…) z.B.  

beispiel1.tif => beispiel1.tfw  

beispiel2.jpg => beispiel2.jgw  

beispiel2.png => beispiel3.pgw“ 

 „Bei der Variante GeoTIFF werden die Werte für die Pixelgröße, Translation der 

Bildmatrix und Rotationswinkel direkt in den Header der TIFF-Datei mit 

entsprechender Software geschrieben. Außerdem können das 

Koordinatensystem und das Bezugsellipsoid angegeben werden.” (LDBV, 2005)  
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Das Rasterbild wird während des Importier-Vorgangs auf das bereits erzeugte Gitternetz 

aufgespannt. Wenn beide Texturen DTK und DOP importiert sind, kann die Szene 

beleuchtet werden. Als Beleuchtungsmittel stehen in Blender verschiedene 

Lampentypen zur Verfügung.  

“Punktlichter (omnidirektionale Lichter) sind Lichter, die in alle Richtungen 

gleichzeitig und in alle Richtungen gleich stark abstrahlen. Alle Lichtstrahlen gehen 

bei diesem Lichttyp von dem gleichen Punkt aus – sie ähneln Glühlampen ohne 

Fassung.  

Direktionale Lichter wie die Sonne strahlen ohne Intensitätsverlust »unendlich 

weit«. Ihre Strahlen verlaufen parallel zueinander.  

Spots ermöglichen es durch Beschränkung des Wirkungsradius, das Licht wie mit 

einem Lampenschirm zu bündeln und fokussieren. 

Flächenlichter simulieren (…) rechteckige Lichtflächen. Während Sie Punktlichter 

problemlos skalieren können, ohne dass die Größenänderung Einfluss auf die 

Helligkeit in der Szene hätte, legen Sie über die Maße eines Flächenlichts genau 

fest, wie groß die vom Licht aussendende Fläche ist.” (Beck, 2018) 

Für diese Bachelorarbeit werden direktionale Lichter verwendet. 

Ist das Landschaftsmodell gut ausgeleuchtet, kann die Kamerafahrt realisiert werden. Die 

Kamera läuft hierbei auf einem Pfad. Ein Empty, ein nicht gerendertes Objekt, bewegt 

sich gleichzeitig als Ziel für die Kamera auf einem weiteren Pfad. Die Bewegung der 

beiden Objekte und die Zielverfolgung werden über eingebundene Constraints, 

sogenannte Zwangsbedingungen, verwirklicht.  

Textbausteine sollen die Orientierung während des Überflugs erleichtern. Ortsnamen 

sollen sich während der Bewegung steht hinsichtlich der Kamera ausgerichtet bleiben. 

Dies wird ähnlich wie die Kamerafahrt über Constraints ermöglicht.  

Die fertiggestellte Kamerafahrt wird nun in Einzelbildern gerendert und abgespeichert. 

Beim Render-Vorgang werden alle Einflüsse der Beleuchtung auf die vorhandenen 

Materialen berechnet und so das fertige Bild erstellt.   
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Die Software Blender besitzt einen eingebauten Video-Editor. Mit diesem können die 

berechneten Einzelbilder als Video-Streifen eingelesen werden. Außerdem wird es 

ermöglicht Überblendungen zwischen den einzelnen Streifen zu schaffen und es könnten 

optional auch Audio-Dateien hinzugefügt werden. Das endgültige Ergebnis wird hier als 

Video-Datei abgespeichert. 

Das Add-on BlenderGIS ermöglicht es in Blender sehr einfach raumbezogene Daten zu 

behandeln. Daher ist es im Gegensatz zu anderen Add-ons oder Möglichkeiten der 

Extrusion von Gitternetzen als Werkzeug für die vorliegende Aufgabenstellung zu 

bevorzugen.  
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3 Workflow einer 3D-Landschaftsvisualisierung 

3.1 Blender installieren 

Auf der Internetseite der Blender Foundation ( https://www.blender.org/download/ ) 

kann die aktuelle Version der Software kostenlos heruntergeladen werden. Die Datei wird 

lokal auf dem Rechner gespeichert und anschließend installiert.   

Der vorliegende Workflow basiert auf Blender 2.81a. 

 

 

Abb.13: Download Blender 

 

 

Abb.14: Startbildschirm Blender 

https://www.blender.org/download/
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3.2 Die Blender Benutzeroberfläche  

 

Abb.15: Hauptteile des User Interface  

3D-View (gelb) 

Im 3D-View findet der Großteil der Animationsarbeit statt.  

Es stehen Werkzeugleisten für Modellierung und Bewegung zur Verfügung. 

 Outliner (rot) 

In diesem Bereich werden alle Objekte der Szene organisiert. 

  Properties Editor (grün) 

Im Properties Editor befindet sich der Großteil aller Einstellungsmöglichkeiten 

bezüglich der Objekte, Materialien, Texturen und der ganzen Szene.  

 Topbar (lila) 

Hier sind Funktionen wie Speichern, Hilfe, etc. und Wahlmöglichkeiten zwischen 

verschiedenen Oberflächen wie Layout, Animation, etc. untergebracht.  

  Timeline (blau) 

Die Organisation der Keyframes (Schlüsselbilder) einer Animation findet hier statt. 

  

1 

2 

3 

4 

5 
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Eine ausführliche Anleitung des User Interface findet man auf der Internetseite:  

https://docs.blender.org/manual/en/latest/getting_started/index.html 

Für die grundlegende Einarbeitung in die Bedienung von Blender sind Video-Tutorials gut 

geeignet. So stellt beispielsweise die Blender Foundation solche Anleitungen für Anfänger 

zur Verfügung. 

https://www.blender.org/support/tutorials/ 

Zahlreiche andere Tutorials sind auf diversen Plattformen im Internet zu finden. Die 

Einarbeitung ist für Neulinge sehr hilfreich und empfehlenswert und wird im Rahmen 

dieses Tutorials nicht weiter besprochen. 

 

 

Abb.16: Blender Tutorials 

  

https://docs.blender.org/manual/en/latest/getting_started/index.html
https://docs.blender.org/manual/en/latest/getting_started/index.html
https://www.blender.org/support/tutorials/
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Nach dem ersten Kennenlernen der Software kann das Add-On BlenderGis als .zip-Datei 

heruntergeladen und lokal auf dem Computer gespeichert werden. Die Seite 

www.github.com stellt diese Erweiterung kostenlos zur Verfügung. 

https://github.com/domlysz/BlenderGIS 

 

Abb.17: Download BlenderGIS 

 

Abb.18: Öffnen Preferences 

Zurück in der Software Blender kann nun unter Edit → Preferences die gespeicherte .zip-

Datei ohne vorheriges Entpacken integriert werden.  

https://github.com/domlysz/BlenderGIS
https://github.com/domlysz/BlenderGIS
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Es öffnet sich das Untermenü Blender Preferences. Hier wird Add-ons → Install 

ausgewählt. Im Blender File View kann die Datei BlenderGIS-master.zip ausgewählt 

werden. Anschließend wird der Installationsvorgang mit Install Add-on bestätigt.  

 

             

Abb.19: Installation Add-ons  

 

 

Abb.20: Auswahl der Add-on Datei  
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Nach der Installation öffnet sich das Blender Preferences Menü. Hier muss der Haken bei 

3D View: BlenderGIS gesetzt werden. Das Add-on ist nun aktiv und steht in Blender zur 

Verfügung. Im Startbildschirm kann die erfolgreiche Installation des Add-ons an dem 

hinzugefügten Reiter GIS im 3D-View oben links erkannt werden.  

 

 

Abb.21: Aktivierung des Add-on 

 

 

Abb.22: Reiter BlenderGIS  
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3.3 Voreinstellungen 

Nachdem sich der Startbildschirm von Blender geöffnet hat, werden alle Default Objekte 

(Camera, Cube und Light) aus dem 3D-Viewport entfernt. Hierzu werden alle Objekte mit 

der Taste [A] ausgewählt. Sie erscheinen mit orange eingefärbter Outline. Es ist zu 

beachten, dass sich bei der Selektion der Mauszeiger im 3D-Viewport befindet. Alternativ 

kann mit gedrückter linker Maustaste ein Auswahlrechteck aufgezogen werden. Sind alle 

Objekte ausgewählt können diese entweder über [X] oder [Entf] entfernt werden. 

 

Abb.23: Markieren aller Default-Objekte 

 

Abb.24: Öffnen Geoscene Manager 

Um die raumbezogenen Grundeinstellungen für die Szene vorzubereiten, wird das 

Untermenü Scene georeferencing geöffnet. Über einen kleinen Pfeil am linken Rand des 

3D-Viewports oder mit der Taste [N] kann dies aufgezogen werden.
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Das Untermenü befindet sich unter View → Geoscene. 

Im Geoscene Manager wird der Raumbezug der Szene über das Zahnrad-Symbol 

festgelegt. Ein neues Koordinatensystem kann über das + Symbol hinzugefügt werden. 

 

 

Abb.25: Menü Scene georeferencing 

 

 

Abb.26: Koordinatensystem hinzufügen 
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Nachdem der Haken bei der Search-Funktion gesetzt wurde, kann über das Eingabefeld 

Query und dem entsprechenden EPSG-Code ein neues Koordinatensystem eingepflegt 

werden. 

Dei in Deutschland gebräuchlichen Systeme werden von EPSG unter folgenden Nummern 

definiert.  

Gauß-Krüger-Zonen 2 bis 5    EPSG:31466 bis EPSG:31469.  

UTM ETRS89 32N und 33N   EPSG:25832 und EPSG:25833 

Im vorliegenden Beispiel wird für ETRS89 / UTM zone 32N → 25832 benutzt.  

Über die Auswahl Save to addon preferences kann das Koordinatensystem für den 

künftigen Einsatz gespeichert werden. Die gemachten Einstellungen werden über OK 

bestätigt.  

 

Abb.27: Änderung des Koordinatensystems 

Anschließend muss über das + Symbol bei der Auswahl Origin der Ursprung der Szene 

definiert werden. Dieser Schritt ist wichtig, damit die eingefügten, georeferenzierten 

Daten nicht zu weit von dem definierten Szenen-Ursprung entfernt sind. Es könnte sonst 

zu Komplikationen während der Darstellung kommen. 

 

Abb.28: Änderung des Koordinatenursprungs 
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Die zu erstellende Visualisierung bewegt sich im Gebiet rund um Eichstätt. Die 

entsprechenden Längen und Breitengrade können auf diversen Online-Portalen ermittelt 

werden. 

Hier ist beispielhaft der Dienst gpskoordinaten.de aufgeführt: 

https://www.gpskoordinaten.de/ 

 

Abb.29: Portal gpskoordinaten 

Eichstätt → Längengrad: 11.1838965° / Breitengrad: 48.8933417° 

Die Auswahl wird mit OK bestätigt und damit sind die Grundeinstellungen bezüglich des 

Raumbezugs eingestellt. Es kann nun begonnen werden, das Geländemodell zu erstellen. 

 

 

Abb.30: Längen- und Breitengrad 

 

  

https://www.gpskoordinaten.de/
https://www.gpskoordinaten.de/
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3.4 Erstellung des Geländemodells 

Im Folgenden wird das bereitgestellte ASCII-Grid importiert. Hierzu wählt unter dem 

Reiter GIS → Import → ESRI ASCII Grid (.asc) ausgewählt.  

Es erscheint ein neuer Bildschirm der verschiedenen Auswahlmöglichkeiten bezüglich des 

Imports ermöglicht.  

 

 

Abb.31: Import ASCII Grid  

 

Abb.32: Import ASCII Grid – Einstellungen  
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Abb.33: Import ASCII Grid – Einstellungen Detail 

Dieses Auswahlmenü bietet die Möglichkeit zwischen Mode Mesh und Point cloud 

auszuwählen.  

Für die vorliegenden Daten empfehlen sich folgende Einstellungen: 

 

Abb.34: Import ASCII Grid – Datei auswählen 

Im Anschluss wird die entsprechende ASCII-Grid-Datei über Volumes gesucht und 

ausgewählt. Nach Auswahl des Befehls Import ASCII Grid startet der Importier-Vorgang. 

Je nach Rechnerleistung und Größe der Datei kann dieser Vorgang bis zu einer Minute 

dauern.  
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Abb.35: Import ASCII Grid - Ergebnis 

Das Gitter erscheint als graue Fläche im 3D-Viewport. Dass eine vertikale Fläche nach 

unten erzeugt wird, liegt an den Ausgangsdaten der BVV. Da es für die weitere 

Visualisierung nicht stört, kann diese Tatsache vernachlässigt werden. 

Im nächsten Schritt wird das erzeugte Gitternetz unter Object → Shade Smooth geglättet.   

 

Abb.36: Shade Smooth 
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3.5 Rasterbilder einfügen 

Um nun diese plastische, jedoch noch farblose, Abbildung etwas natürlicher erscheinen 

zu lassen, wird im folgenden Schritt ein georeferenziertes Rasterbild über das erzeugte 

Gitternetz gespannt. Mit dem Werkzeug GIS → Import → Georeferenced raster werden 

verschiedene Bildformate in die Blender-Umgebung eingefügt. 

 

Abb.37: Import georeferenced raster 

Es öffnet sich ein Dialogfeld mit verschiedenen Einstellungsmöglichkeiten. Da das Bild auf 

das bereits erzeugte Gitter aufgespannt werden soll, wird unter Mode → Basemap on 

mesh ausgewählt. Unter Objects wählt man das importierte ASCII Grid. Da alle Geodaten 

in ETRS89 / UTM zone 32N projiziert sind, bleibt die Einstellung unter CRS gleich. 

Nachdem über Volumes der richtige Dateipfad gefunden und die entsprechende Datei 

ausgewählt ist, wird der Importier-Vorgang über Import georaster gestartet.  

 

Abb.38: Import georeferenced raster – Auswahl Datei 
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Wie bereits bei dem Hinzufügen des ASCII Grid, ist auch hier Geduld gefragt. Bei großen 

Bilddaten können mehrere Minuten vergehen, bis das Ergebnis im 3D-Viewport zu sehen 

ist. 

 

Abb.39: Import georeferenced raster – Ergebnis 

Auf dem gleichen Weg wird die zweite Textur hinzugefügt. 

GIS → Import → Georeferenced raster 

Mode: Basemap on mesh → Kontrolle ASCII-Grid → Datei auswählen → Import georaster 

Im 3D-Viewport erscheint erneut das Gitter mit der Oberfläche des Bildes, das zu Beginn 

eingefügt wurde. Es ist ratsam, vor dem Wechsel der Textur, die verschiedenen 

Oberflächen mit distiktiven Namen zu versehen. Hierzu wählt man im Properties Editor, 

im Unterpunkt Materials Properties mit einem Doppelklick das entsprechende Material 

aus und ändert den Namen. 

 

Abb.40: Import georeferenced raster - Namensänderung 
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Um nun zwischen den Oberflächen zu wechseln, wird der Curser in den 3D-Viewport 

bewegt. Das Gitternetz muss aktiv gesetzt sein. Dann wird [TAB] gedrückt oder in der 

Menüleiste Edit Mode ausgewählt. Die Oberfläche erscheint nun in einem orangen 

Farbton. Sollte das Gitternetz schwarz erscheinen, muss es mit dem Cursor im 3D-

Viewport und [A] ausgewählt werden. Hierbei ist zu beachten, dass keine anderen 

Objekte, wie Kamera oder Beleuchtung, im 3D-Viewport mitausgewählt wurden.  

 

Abb.41: Wechsel zwischen DTK und DOP 

Nun wird die neue Textur aktiv gesetzt und über Assign der Wechsel bestätigt. Nun 

bewegt man den Curser wieder in den 3D-Viewport und drückt erneut [TAB] . Das 

Gitternetz erscheint nach einiger Rechenzeit bespannt mit der neuen Oberfläche. Um die 

zukünftige Rechenzeit etwas zu verkürzen, kann das fertige Landschaftsmodell nun 

skalliert werden. In der Originalausdehnung von ungefähr 16000 m x 10000 m treten 

auch Schwierigkeiten bezüglich der Kamerafahrt auf. Für die Visualisierung ist es 

unerheblich, ob die Originalgröße vorliegt. Alle benötigten georeferenzierten Texturen 

sind bereit mit dem Gitternetz verbunden. Im diesem Fallbeispiel wird ein 

Skalierungsfaktor 0.05 für die X -  und Y - , sowie 0.1 für die Z – Richtung verwendet. Die 

leichte Überhöhung in Z -Richtung macht die Landschaft ansprechender für das Auge des 

Betrachters.   
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Diese Einstellungen nimmt man in dem Menü, das am rechten Rand des 3D-View 

eingeblendet werden kann, unter dem Reiter Item vor. Wichtig ist hierbei, dass das 

Landschaftsmodell das aktive Element in der Scene Collection ist.  

 

Abb.42: Einstellung des Scalefaktors 

Um die aktive Landschaft nach der Skalierung wieder in den Szenenursprung zu legen,  

wird das Gitternetz über die Move Funktion mittig über das Ursprung-Symbol 

geschoben. Dies ist gut im Top-View der Abb.43 zu erkennen.   
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3.3 Beleuchtung 

Der 3D-Viewport wird nun auf Rendered Display umgestellt. Es wird deutlich, dass zu 

Beginn des Projekts alle Lichtquellen gelöscht wurden. Die Landschaft erscheint, als wäre 

es kurz nach Sonnenuntergang und daher ist es nötig, neue Lichter zu setzen. Es empfiehlt 

sich, stets einen Blick auf die Szene in der Ansicht Rendered Display zu werfen oder die 

Einstellung dauerhaft zu belassen. Nur so können die Lichtverhältnisse und Farben 

überprüft werden, wie sie auch im Endprodukt erscheinen.  

Als Beleuchtungsmittel stehen unterschiedliche Lampentypen zur Verfügung. Diese 

können über die Menü-Auswahl Add oder [Shift] + [A] eingefügt werden. 

 

Abb.43: Umstellung auf Rendered View 

 

Abb.44: Lichtquelle hinzufügen 
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Für dieses Beispiel werden direktionale Lichter (Sun) verwendet. Es werden drei Sonnen 

mit um das Gitternetz angeordnet. Hierbei wird bei der linken Sonne die Stärke (Strength) 

im Object Data Properties von 2.0 eingestellt. Die beiden anderen erhalten eine Stärke 

von 0.5. Dieser Aufbau soll jedoch ausdrücklich nur als Vorschlag betrachtet werden und 

wurde bewusst einfach gewählt. In diesem Bereich liegt viel Potential, die eigenen 

Fertigkeiten weiter auszubauen. Um einen möglichen Glanzeffekt der Oberfläche zu 

vermeiden, sollte unter Materials properties der Roughness – Faktor beider Texturen auf 

den Wert 1 eingestellt werden. 

 

Abb.45: Einstellung der Leuchtkraft 

 

Abb.46: Einstellung der Roughness  
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3.4 Kamerafahrt 

Zu Beginn sollten Einstellungen bezüglich der Anzahl an Bildern im Properties editor 

unter Output Properties getroffen werden. Zur Einschätzung der zeitlichen Komponente 

kann man die Anzahl der Frames durch die Frame Rate teilen 
1500 𝑓𝑟𝑎𝑚𝑒𝑠

24 𝑓𝑟𝑎𝑚𝑒𝑠 / 𝑠𝑒𝑐𝑜𝑛𝑑
 = 62.5 

seconds. Das bedeutet, dass die später erzeugte Videodatei mit 1500 Bildern ungefähr 

eine Minute Spielzeit hat.  

 

Abb.47: Auflösung und Anzahl an Bildern 

Nun werden diverse Bewegungspfade eingefügt. Das folgende Konzept der Kamerafahrt 

soll, wie auch schon bei der Thematik Beleuchtung, nur als ein Lösungsvorschlag gesehen 

werden. Mit dem Cursor im 3D-Viewport und den Tasten [SHIFT]+[A] wird eine Bezier-

Curve und ein Nurbs Circle eingefügt.  

 

 

Abb.48: Bezier Curve einfügen 

 

  

Abb.49: Nurbs Circle einfügen
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Anschließend werden der Kreis und die Kurve mit gedrückter Taste [S] oder numerisch 

über das Item Transform Menü skaliert. Als Startwerte können hierfür beispielsweise für 

die Bezier-Curve X,Y → 400 und den Nurbs-Circle X → 350, Y → 150 verwendet werden.  

Im nun folgenden Schritt wird die Bezier-Curve aktiv gesetzt und in den Edit Mode 

gewechselt. 

 

 

Abb.50: Nurbs Circle Scale 

 

Abb.51: Edit Mode  
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Die Empfehlung ist, eine nur leicht geschwungene Linie zu modellieren. Stützpunkte 

können durch Anklicken aktiv gesetzt und dann über das Move Werkzeug verschoben 

werden. Der aktive Stützpunkt erscheint weiß.  

 

Abb.52: Verschiebung eines Stützpunkts  

 

Abb.53: Bezier Curve 
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Es empfiehlt sich auch die Pfade im Properties editor mit eindeutigen Namen, 

beispielsweise Nurbs Circle → CameraPath und Bezier Curve → TrackingPath zu 

versehen.  

Die beiden Kurven werden jeweils im markierten Zustand mit der  Tastenkombination 

[Alt] + [G] und [Alt]+[R] in eine zum Szenenursprung neutrale Stellung gebracht. Dies kann 

auch im Transform Menü [N]unter Item eingestellt werden. Dies wird empfohlen, um die 

Constraints in neutraler Stellung einzufügen.  

 

Abb.54: Neutrale Stellung  

Nun wird ein Empty mit [Shift] + [A] oder über den Reiter Add eingefügt. Ein Empty ist ein 

Objekt, das keine konstruktiven Daten besitzt und nicht gerendert wird. In diesem 

Anwendungsfall wird es benutzt, um der Kamera ein Ziel zu bieten. Die Form kann frei 

gewählt werden.  
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Abb.55: Empty hinzufügen  

Das Empty wird auf eine brauchbare Größe skaliert, beispielsweise X, Y, Z → 20 und dem 

individuellen Namen Target versehen. Die Location und Rotation mit [Alt] + [G] und [Alt] 

+ [R] nun wieder in neutrale Stellung zu bringen. Im nächsten Schritt das Empty mit einem 

Follow Path Constraint hinterlegen. 

 

Abb.56: Follow Path Constraint 
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Abb.57: Follow Path Constraint - Einstellungen 

Die Achsausrichtungen werden für Forward und Up mit den Werten -Z und Y belegt. Die 

beiden Optionen Follow Curve und Fixed Position werden ausgewählt. Nun wird die 

Bezier Curve knapp unter die Landschaft verschoben.  

 

Abb.58: Verschiebung Tracking Path 
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Nachfolgend wird mit [Shift] +[A] einer Kamera und ein weiteres Empty, in Form eines 

Cube, der Szene hinzugefügt. Beide werden skaliert, XYZ →20. 

Sind beide Objekte in neutrale Stellung gebracht, [Alt] + [G] und [Alt] + [R], werden sie 

über eine Parent-Child-Beziehung miteinander verknüpft. Hierzu wird zuerst die Kamera 

ausgewählt, dann das Empty. Beide erscheinen orange, jedoch ist das erstmarkierte 

Objekt etwas dunkler im Farbton. Über Object → Parent →Object wird nun die Beziehung 

eingefügt.  

 

Abb.59: Parent-Child-Beziehung 

Über einen Follow Path Constraint wird nun das Empty an den Pfad CameraPath 

gebunden. Alle beteiligten Objekte sollten wiederum in neutrale Stellung bezüglich 

Location und Rotation gebracht werden, [Alt] + [G] und [Alt]+[R].  
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Die beiden Optionen Follow Curve und Fixed Position werden wieder ausgewählt.          Die 

Kamera wird nun über den Track to Constraint auf das Empty (Target) ausgerichtet. Die 

Achsausrichtungen werden für Forward und Up mit den Werten -Z und Y belegt. 

 

 

Abb.60: Follow Path Constraint 

 

Abb.61: Track To Constraint 
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In einem nächsten Schritt erfolgt die Teilung des 3D-Viewports. Dies geschieht durch 

das Aufziehen eines neuen Bildschirms in den Ecken des Viewports. Die Fenster werden 

wieder durch einen Rechtsklick auf die Grenze und Join Area verschmolzen. 

 

 

Abb.62: Viewport teilen 

 

 

Abb.63: Viewports verschmelzen 

 

 

Abb.64: Camera Perspective 

Um die richtige Kamerafahrt festzulegen, empfiehlt es sich, bei einem der beiden 

Fenster in die Camera Perspective zu wechseln. Dies geschieht mit dem Cursor im 

entsprechenden Fenster und der Taste [0] auf dem Nummernblock gedrückt. Ebenso 

macht es Sinn, die Timeline im unteren Bereich des Bildschirms zu vergrößern.  
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Nun wird die über die beiden Offset-Einstellungen der Follow-Path-Constraints die 

Kamerafahrt entwickelt. Zu Beginn setzt man die Timeline auf Frame 1 und den Offset 

des Target Empty auf 0. Im Anschluss daran wird diese Position durch ein Schlüsselbild 

(Keyframe) festgehalten. Einzelne Keyframes werden in der Timeline platziert, indem 

der Cursor über das Offset-Einstellungsfeld geführt wird. Dann wird durch Drücken der 

Taste [I] in der Timeline eine gelbe Schlüsselbild-Markierung eingefügt. Auf Frame 1250 

wird der Offset auf 1, auf Frame 2500 wieder auf 0 eingestellt und jeweils ein Keyframe 

gesetzt.  

 

Abb.65: Target Keyframe 

Das Cube-Empty, das mit der Kamera über die Parent-Child-Beziehung verbunden ist, 

wird als nächstes aktiv gesetzt. Auf Frame 1 wird der Offset auf 0 und auf Frame 2500 auf 

1 eingestellt. Beide Einstellungen werden als Schlüsselbilder in der Timeline fixiert. 

 

Abb.66: Camera Path Keyframe 
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Mit dem Drücken der Leertaste wird die Animation gestartet. Der Camera Cube bewegt 

sich ruhig und mit gleichbleibender Geschwindigkeit entlang dem Camera Path. Das 

Target folgt der Spur entlang der Bezier-Curve. Diese ruhige Bewegung ist das 

Grundgerüst der Visualisierung. Nun wird die Timeline wieder auf Frame 1 eingestellt und 

die Kamera aktiv gesetzt. Da die Kamera den Empty als Parent hat, kann sie unabhängig 

von seiner Fahrt frei bewegt werden. Ist eine ansprechende Einstellung gefunden wird 

sie in der Timeline fixiert. Hierzu wird der Cursor über Location im Transform-Menü [N] 

bewegt und mit gedrückter Taste [I] ein Keyframe eingefügt.  

Mit dem Cursor über dem ersten Keyframe und rechter Maustaste gedrückt, wird die 

Option Duplicate, oder [Shift] + [D] ausgewählt. So wird die erste Position der Kamera 

kopiert und auf das Endframe 2500 gesetzt. Es ist so sichergestellt, dass die Kamera an 

dem Platz ankommt, an dem die Fahrt begonnen hat.  

 

 

Abb.67: Kamera Keyframe 

 

Abb.68: Kamera Keyframe letzes Bild 
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Folgend können etwa alle 200 Frames neue Keyframes für die Position der Kamera 

gesetzt werden. Soll später bei Frame 400 doch eine andere Position der Kamera gewählt 

werden, kann dies nachträglich geändert werden. Ist die neue Einstellung eingerichtet 

und in der Timeline Frame 400 eingestellt, wird der Cursor über das Location 

Einstellungsfeld bewegt. Mit der rechten Maustaste öffnet sich ein Menü und es kann 

Replace Keyframes gewählt werden.  

 

Abb.69: Replace Keyframes 

 

Abb.70: Fertige Kamerafahrt 

 

 



3 Workflow einer 3D-Landschaftsvisualisierung 55 
 

3.5 Text einfügen 

Nach Fertigstellung der Kamerafahrt bewegt man den Cursor wieder in den 3D-

Viewport und fügt mit der Tastenkombination [SHIFT]+[A] ein Text-Objekt in die Szene 

ein. Mit gedrückter Taste [S] oder numerisch wird der Textbaustein auf eine 

ansprechende Größe skaliert, in etwa auf Scale X, Y = 10.  

 

Abb.71: Text einfügen 

 

 

Abb.72: Text skalieren manuell 

 

 

 

Abb.73: Text skalieren numerisch
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Nun wird die Position des Textes über den geteilten Bildschirm im Camera View 

eingestellt und kontrolliert. Es empfiehlt sich die Schrift leicht schräg zur Landschafts-

Oberfläche zu positionieren.  

 

Abb.74: Text ausrichten 

Den Inhalt des Textes verändert man im 3D-View im Edit Mode [TAB].  

In Object Data Properties kann der verwendete Font verändert werden. Außerdem ist es 

möglich den Text zu extrudieren und die Räume zwischen den einzelnen Buchstaben zu 

vergrößern. Diese Einstellungen sind jedoch nur optional. Eine neue Farbe wird unter 

Material Properties eingestellt. 

 

 

Abb.75: Text Einstellungen 

 

 

Abb.76: Text Farbe ändern 
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Ist die Ausrichtung, Größe und Farbe des Textblocks nach Geschmack eingestellt, wird ein 

Track To Constraint, mit Target: Camera eingefügt. Die Belegung der Achsen sollte To: Z 

und Up: Y sein. Falls der Text verschoben erscheint, muss eine andere Kombination der 

Achsen versucht werden. Es sollten jedoch nicht bei To und Up die gleichen Achsen 

ausgewählt werden. 

 

Abb.77: Text Track To Constraint 

Verbleibend im gleichen Frame in der Timeline dupliziert man den Textbaustein mit der 

Tastenkombination [SHIFT]+[D]. Nun verschiebt man diese Duplikate, am Besten in der 

Draufsicht, über weitere markante Punkte auf der Karte und ändert den Inhalt 

entsprechend.                  

Um eine weitere Bearbeitung zu erleichtern, sollten den duplizierten Text-Objekten auch 

distinktive Namen geben werden.  



3 Workflow einer 3D-Landschaftsvisualisierung 58 
 

3.6 Rendering 

Sind alle Einstellungen vorgenommen und überzeugt das Ergebnis des Testdurchlaufs im 

Camera View, kann man sich daran machen, die Einzelbilder der Visualisierung zu 

rendern. Hierzu weist man einen Zielordner zu, in welchem die Bilder abgelegt werden 

sollen. In einem nächsten Schritt startet man den Vorgang unter Render → Render 

Animation. Nun werden Einzelbilder gerechnet und abgespeichert. Sollte der Vorgang 

einmal abgebrochen werden, kann bei dem letzten berechneten Bild eingesetzt werden 

und es muss nicht wieder bei Frame 1 begonnen werden. 

 

Abb.78: Einstellungen Render 

Nun wird die Textur gewechselt und erneut alle Bilder gerendert. Um beim 

nachfolgenden Videoschnitt flexibler arbeiten zu können, sollten mit beiden Texturen alle 

Bilder gerendert werden. Wird die DTK als Textur verwendet, kann es gestalterisch 

stimmiger erscheinen, wenn die Textblöcke nicht mitgerendert werden.   
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Das Menü Restriction Toggles befindet sich hinter dem kleinen Trichtersymbol am 

rechten oberen Rand. Hier wird die kleine Kamera aktiv gesetzt. Nun bekommt der 

Outliner die Auswahloption Objekte nicht rendern zu lassen. Über das Augensymbol kann 

gesteuert werden, ob ein Objekt im 3D-Viewport sichtbar ist. Durch das Ausblenden des 

Kamerasymbols entscheidet der Nutzer, dass ein Element nicht im gerenderten 

Endergebnis zu sehen ist.  

 

Abb.79: Restriction Toggles 

 

Abb.80: Text nicht rendern 
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3.7 Videoschnitt 

Öffnet man die Blender interne Video Editing Oberfläche, exemplarisch über den 

entsprechenden Tab in der Topbar, erscheint eine neue Benutzeroberfläche.  Sollte der 

Tab noch nicht vorhanden sein, wird über das + Symbol der Menüpunkt Add Workspace 

geöffnet und der Video Editing Tab hinzugefügt. Die berechneten Einzelbilder werden in 

den Editor über das Menü Add → Image/Sequence eingefügt. Im Video Editor befindet 

sich das Add Menü über die Timeline. 

 

Abb.81: Video Editing öffnen 

 

Abb.82: Video Editing Add 

 



3 Workflow einer 3D-Landschaftsvisualisierung 61 
 

 
Da es in diesem Beispiel angedacht ist, eine Überblendung zwischen der digitalen 

topographischen Karte und dem digitalen Orthofoto zu generieren, empfiehlt es sich, die 

Bildstreifen mit einer Überlappung von zirka 100 Bildern zu importieren (z.B. DOP Frame 

1 – 250 → DTK Frame 150 – 450 → DOP Frame 350 – 650 …). 

 

 

Abb.83: Anordnung der Video Strips und Steuerung Opacity 

 

Abb.84: Video Editing Einstellungen 
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Im Menü Scene wird ein geeigneter Speicherordner ausgewählt und das Format FFmpeg 

video mit Encoding MPEG-4 eingestellt.  

Die Überblendung wird über das Eingabefeld Opacity realisiert. Am Beginn der 

Überlappung mit der Taste [I] und dem Cursor über dem Opacity Feld ein Keyframe 

eingefügt. Hierbei ist der aktuelle Videostreifen auf Opacity = 1 einzustellen und der 

überblendende auf Opacity = 0. Am Ende der Überlappung, z.B. 100 Bilder später, setzt 

man zwei weitere Keyframes und tauscht die beiden Angaben für Opacity aus. So entsteht 

eine weiche Überblendung zwischen den beiden Videostreifen.  

Ist das Ergebnis in der Vorschau zufriedenstellend kann über Render → Render Animation 

das Video abgespeichert werden.  

 

Abb.85: Render Animation 
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5 Diskussion und Ausblick in die Zukunft 

Um die Entwicklung eines Workflows zur Erstellung einer 3D-Landschaftsvisualisierung zu 

realisieren, wurde die Open Source Software Blender auf die Tauglichkeit 

georeferenzierter Daten zu verarbeiten näher untersucht. Auf dieser Basis lässt sich 

feststellen, dass diese Anwendung durchaus Potential hat, die gestellten Aufgaben zu 

erfüllen. Darüber hinaus kann sie als Schulungssoftware am Landesamt für 

Digitalisierung, Breitband und Vermessung eingesetzt werden.  

Zu Beginn wurden etliche Anwendungsmöglichkeiten bezüglich der verfügbaren 

Werkzeuge untersucht. Die Erwartung, den geodätischen Raumbezug der Ausgangsdaten 

zufriedenstellend umzusetzen, konnte erst das Add-on BlenderGIS erfüllen. Im weiteren 

Verlauf wurde ein Workflow entwickelt, der es in Umfang und Komplexität auch 

fachlichen Einsteigern ermöglicht, eine ansprechende, dreidimensionale 

Landschaftsvisualisierung als vorgerenderten Animationsfilm zu erstellen. 

„Die Anzahl an verbreiteten Anwendungen von 3D-Geovisualisierungen, 

insbesondere durch den Einfluss von Geodatendiensten, wie z.B. Google Earth, 

zeigen die Attraktivität und Popularität dieser Darstellungsmethode. Die Vorteile 

zur Interpretation räumlicher Strukturen ergeben sich aufgrund der leichten und 

intuitiveren Wahrnehmung des Raumes.“ (Zenner, Asche, Wolff, 2008) 

Da bei einer fortschreitenden Technisierung unseres alltäglichen Lebens auch vermehrt 

Visualisierungen zur Informationsvermittlung genutzt werden, sollte auch im Berufsfeld 

der Geodäsie und Kartographie kompetent mit diesen Werkzeugen umgegangen werden. 

Hierzu ist es nötig Auszubildende und Studierende Schritt für Schritt an diese Fähigkeiten 

heranzuführen.  

Eine Empfehlung für weitere Untersuchungen in diesem Bereich könnte die 

Übertragbarkeit der Ergebnisse aus Blender in eine VR / AR Umgebung, beispielsweise 

Unity sein.  
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